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Trademark Information

FontDoctor is a trademark of Morrison SoftDesign, Inc. Apple, Mac, the Mac logo, and Macintosh are trade-
marks of Apple Computer, Inc., registered in the United States and other countries. All other trademarks are
the properties of their respective owners.

The software described in this manual is distributed under license from Morrison SoftDesign, Inc. The license
agreement specifies the permitted and prohibited uses of this software. Any unauthorized duplication or use
of FontDoctor in whole or in part, in print, or in any other storage or retrieval system is prohibited.

Disclaimer of Warranties
EXCEPT AS PROVIDED ABOVE, THIS SOFTWARE, CONTENT, AND/OR AND ANY RELATED SERVICES ARE PROVID-
ED “AS-IS,” AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, MORRISON SOFTDESIGN AND
ITS SUBSIDIARIES, AFFILIATES, LICENSORS, PARTICIPATING, THIRD-PARTY CONTENT OR SERVICE PROVIDERS,
DISTRIBUTORS, DEALERS OR SUPPLIERS (“REPRESENTATIVES”) DISCLAIMS ALL OTHER REPRESENTATIONS AND
WARRANTIES, EXPRESS OR IMPLIED, REGARDING THIS SOFTWARE, DISK(S), RELATED MATERIALS AND ANY
SERVICES, INCLUDING THEIR FITNESS FOR A PARTICULAR PURPOSE, THEIR QUALITY, THEIR MERCHANTABILITY,
OR THEIR NONINFRINGEMENT. MORRISON SOFTDESIGN DOES NOT WARRANT THAT THE SOFTWARE IS FREE
FROM BUGS, VIRUSES, ERRORS, OR OTHER PROGRAM LIMITATIONS, INCLUDING BUT NOT LIMITED TO ACCU-
RATE OR UPDATED THIRD-PARTY CONTENT, NOR DOES MORRISON SOFTDESIGN WARRANT ACCESS TO THE
INTERNET OR ANY OTHER SERVICE THROUGH THE SOFTWARE. YOU ACKNOWLEDGE AND AGREE THAT YOU
MUST: (A) PROVIDE YOUR OWN ACCESS TO THE INTERNET AND PAY ANY SERVICE FEES ASSOCIATED WITH
SUCH ACCESS, AND (B) PROVIDE ALL EQUIPMENT NECESSARY FOR YOU TO MAKE SUCH CONNECTION TO THE
WORLD WIDE WEB, INCLUDING A COMPUTER AND A MODEM. SOME STATES DO NOT ALLOW THE EXCLUSION
OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSIONS MAY NOT APPLY TO YOU. IN THAT EVENT, ANY IMPLIED
WARRANTIES ARE LIMITED IN DURATION TO THIRTY (30) DAYS FROM THE DATE OF PURCHASE OF THE
LICENSE FOR THE SOFTWARE. HOWEVER, SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN
IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU
SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER RIGHTS AS WELL, WHICH VARY FROM STATE TO STATE.

Limitation of Liability and Damages
THE ENTIRE LIABILITY OF MORRISON SOFTDESIGN FOR ANY REASON SHALL BE LIMITED TO THE AMOUNT PAID
BY THE CUSTOMER FOR THE SOFTWARE LICENSED FROM MORRISON SOFTDESIGN OR ITS AUTHORIZED
RESELLER. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, MORRISON SOFTDESIGN AND ITS
REPRESENTATIVES ARE NOT LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO: DAMAGES FOR LOSS OF BUSINESS, LOSS OF PROFITS OR INVESTMENT, OR
THE LIKE), WHETHER BASED ON BREACH OF CONTRACT, BREACH OF WARRANTY, TORT (INCLUDING NEGLI-
GENCE), PRODUCT LIABILITY OR OTHERWISE, EVEN IF MORRISON SOFTDESIGN OR ITS REPRESENTATIVES HAVE
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, AND EVEN IF A REMEDY SET FORTH HEREIN IS
FOUND TO HAVE FAILED OF ITS ESSENTIAL PURPOSE, MORRISON SOFTDESIGN AND ITS REPRESENTATIVES’
TOTAL LIABILITY TO YOU FOR ACTUAL DAMAGES FOR ANY CAUSE WHATSOEVER WILL BE LIMITED TO THE
AMOUNT PAID BY YOU FOR THIS SOFTWARE. SOME STATES DO NOT ALLOW THE LIMITATION AND/OR EXCLU-
SION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION
MAY NOT APPLY TO YOU.
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FontDoctor Overv i e w
Fonts are a major source of problems and confusion on the Macintosh. Corrupt fonts, multiple versions of the
same font, confusion about which font is which, and more can cost you time and money. FontDoctor is the
leading software tool for diagnosing and repairing font problems, organizing font files, archive font files, and
providing insight into your fonts through previews and printed samples. With FontDoctor, you can be assured
that your font library is corruption-free and carefully organized. FontDoctor works by:

• Eliminating font problems that wreak havoc on system performance and applications by looking at a single
font, scanning fonts in a folder, or finding all the fonts on a local hard drive or over a network. 

• Diagnosing and repairing common font issues, including missing PostScript fonts, missing bitmaps, corrupt/
damaged fonts, font ID conflicts, extra fonts sizes, mixed fonts types, and more. 

• Automatically organizing font files by font name, family name, alphabetically, or a host of other flexible font
organization options.

• Archiving safe back-up copies of your fonts for later retrieval and restoration.

• Printing reports summarizing diagnosis and organization results, converting font types, and moving fonts
within suitcases. 

FontDoctor lets you preview and print custom previews of any font. Automatically create a new font library, organized the 
way you prefer.
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About MorrisonSoftDesign
Morrison SoftDesign is a professional software development company specializing in font software for Apple
Macintosh and Windows computers and the publishing industry. All of our products come with a full 30-day
Money Back Guarantee, free technical support, and free software updates. Please feel free to contact us if
you have any questions or comments regarding any of our products or services. We value your ideas!

Morrison SoftDesign, Inc.
8124 Grahamson Lane, Suite 102
Charlotte, NC 28269
1-800-583-2917
704-992-0412 (fax)
info@MorrisonSoftDesign.com

Contacting Technical Support
If you encounter any problems with FontDoctor, complimentary technical support is available the internet or 
e-mail from 8 a.m. to 5 p.m. EST.

• www.MorrisonSoftDesign.com (or www.FontDoctor.com)

• techSupport@MorrisonSoftDesign.com

You can also choose E-Mail Technical Support from the Help menu or visit MorrisonSoftDesign.com and
click Support.

Updating FontDoctor
To check for updates to FontDoctor, or to visit the Morrison SoftDesign Web site for any reason, choose
Check For FontDoctor Update from the Help menu.

The FontDoctor Help menu.
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Getting Started
System Requirements

FontDoctor for Macintosh is available for:

• Mac OS X (version 10.1 or higher)

• Mac OS 9/Classic

Font Doctor supports fonts in the following formats:

• PostScript Type 1 and PostScript Type 3

• TrueType in Macintosh or Windows (.ttf) formats

• Multiple Master

• OpenType

• dfonts (Apple’s Mac OS X datafork fonts)

• Bitmap/Suitcase Files

Installing and Registering FontDoctor
You can install FontDoctor from a download or a CD as follows:

1 Insert the FontDoctor CD or unstuff the downloaded file.

2 Drag the FontDoctor for Macintosh folder to your Applications folder or any other location where you would
like to store it. 

3 Double-click the FontDoctor or FontDoctor X icon.

4 In the Register FontDoctor™ For Macintosh dialog box, enter the appropriate information in the Name
and Company Name fields.
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5 In the Serial Number field, enter the number printed on the installer CD envelope or received via e-mail.
You must enter the serial number exactly as it appears. If you have not yet purchased FontDoctor, click
Demonstration to preview a limited version.

The Register FontDoctor™ For Macintosh dialog box.

6 Click OK to complete the installation process.

7 When the “thank you” message displays, click OK.

8 Click the splash screen to display the FontDoctor window and start using the program.

Installing a Demo Version
The demo version of FontDoctor does not let you repair, move, or organize fonts. You can experiment with the
demo version for an unlimited amount of time, but we encourage you to register for access to all FontDoctor
features, complimentary technical support, and free updates.

To install a demo version, follow the steps in the previous section, “Installing and Registering FontDoctor,”
except click Demonstration in step 5. A prompt reminds you of the demo limitations and provides the regis-
tration information. Click OK to start experimenting with FontDoctor.

The demo alert, which lists demo limitations and provides contact information for registration.

When you’re ready to register FontDoctor, launch it and enter the serial number in the Register FontDoctor
For Macintosh dialog box.
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Quick Start
If you purchased FontDoctor because you suspect that corrupt fonts are causing problems on your system,
follow these steps to dive right in, diagnose the fonts, and start solving the problems. Depending on how
many fonts you have, the process may take a while. You may, however, need to stay close to your computer
to respond to some prompts. 

1 If possible, determine which folder on your system contains the problems fonts. For example, if the prob-
lems started when you received new fonts from a client for output, you might be able to diagnose just
those fonts.

2 Launch FontDoctor. The Diagnose/Repair Fonts tabbed panel displays by default.

3 To concentrate on corrupt fonts—rather than other font issues such as duplicate fonts— click the
Diagnosis Options button in the lower-left corner of the tabbed panel. Uncheck all of the group checkboxes
except the Font File Structure Options checkboxes. By default, FontDoctor will look for and repair the fol-
lowing common font problems when diagnosing corrupted fonts:

• Missing Style Resources

• Empty Suitcase Files

• Bitmap Table Data

• Finder File Flags

• Old FONT Resource Types

4 Make sure Include Sub-Folders is checked in the lower-left corner of the tab. This ensures that FontDoctor
reviews all possible font files. (Note that other file types are ignored.)
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5 Drag and drop a folder, disk, or drive containing the suspect fonts into the Diagnosis area at the top of the
Diagnose/Repair Fonts tab.

6 When FontDoctor encounters problems, the Diagnosis dialog box displays. Click Fix All to repair the fonts.

The Diagnosis dialog box reports problems and lets you fix them. 

8 When the diagnosis and repair process is finished, a summary displays. Click OK to close the summary and
display a report. If you find the report information useful, you can save or print it. Otherwise, click Done.

The summary that displays at the end of the diagnosis process. 

9 If you think FontDoctor found and repaired the problem fonts, you can quit the application and resume
working. If not, you may wish to diagnose more of your fonts. 

If you have any questions about the specifics of the diagnosis process, see “Examining and Repairing Fonts”.
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The FontDoctor Interface
FontDoctor’s standard Mac OS interface consists of the main FontDoctor window and several menus. When
the application is running, the FontDoctor window is always open.

Launching FontDoctor
To launch FontDoctor, simply double-click its icon in the FontDoctor folder inside your Applications folder. For
easier access to FontDoctor, drag it to the dock (Mac OS X) or place an alias in the Apple menu (Mac OS 9).

The FontDoctor X application icon.

To quit FontDoctor, press ⌘+Q, click the FontDoctor window’s close box, or choose Quit FontDoctor from
the FontDoctor X menu (Mac OS X) or the File menu (Mac OS 9).

The FontDoctor Window
The FontDoctor window, which displays whenever FontDoctor is running, provides three panels of features.
To display a different panel, click one of the tabs at the top of the main window: Diagnose/Repair Fonts,
Organize Fonts, or Archive Fonts. 

Expanding the FontDoctor Window
You can expand the FontDoctor window to the size of your monitor by clicking the maximize box on the win-
dow, dragging the resize box in the lower-right corner, or choosing Zoom Window (⌘+/) from the Window
menu. To restore the FontDoctor window to its original size, click the maximize box again or choose
Minimize Window (⌘+M) from the Window menu.

Displaying Context Menus
Control+click within any tab to display a menu (called a “context menu”) of helpful shortcuts. 
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Diagnose/Repair Fonts Tab

The Diagnose/Repair Fonts tab lets you diagnose fonts for possible problems. You can drag any drive, disk,
or folder into the tab to start diagnosing the fonts within it. The Diagnosis Options area lets you specify
what to check the fonts for, and the Expert Options button displays options that let you customize the diag-
nosis. Option+click any check box in the Diagnosis Options area to check or uncheck all the boxes.

The Diagnose/Repair Fonts tabbed panel and it’s context menu.

Organize Fonts Tab

The Organize Fonts tab lets you select a drive, disk, or folder of fonts; find the fonts within it; and reorganize
them into a new folder structure. You can specify which fonts to find and how they should be organized (for
example, into folders named A, B, C, etc.). Option+click any check box in the Search Options area to check
or uncheck all the boxes.

The Organize Fonts tab and its context menu.
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Archive Fonts Tab

The Archive Fonts tab lets you create a portable font Archive file that contains safe back-up copies of your
font files. This allows you to later find and restore any font files you may need quickly and easily.

The Archive Fonts tab and it’s context menu.

The FontDoctor Menus
The FontDoctor menus provide access to standard Macintosh commands such as Quit and Preferences, and
to less commonly used features such as Examine a Font File and Move Fonts. Due to different Mac OS
standards, the standard menus for the Mac OS X and Mac OS 9 software vary slightly.

• The Mac OS X only FontDoctor X menu provides access to preferences and lets you quit FontDoctor.

• The File menu lets you create a new font suitcase, examine an individual font file, and export FontDoctor
settings and information. In Mac OS 9, you can quit FontDoctor from the File menu.

• The Tools menu lets open the Inspect Fonts window, the Convert Fonts window, and the Move Fonts win-
dow along with providing access to the Clean Font Cache Folders feature.

The FontDoctor X menu. The File menu. The Tools menu.

• The Window menu lets you resize the FontDoctor window.

• The Help menu lets you access this user guide, check for updates, and contact technical support.

The Window menu. The Help menu.
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Examining and Repairing Fo n t s
FontDoctor’s examination process has two purposes: to fix corrupt fonts and to clean up your font library.
You can turn off the options for cleaning up your font library, but FontDoctor always examines for corruption.
If you’re just getting started with FontDoctor, you might want to first fix corrupt fonts and clean up your
entire font library. Then, you can periodically examine fonts for corruption. 

FontDoctor can do everything from examine a single font file to finding and examining all the fonts on an
entire volume. Diagnosis Options available through the Diagnose/Repair Fonts tab let you decide exactly
what FontDoctor is checking for, including resolving font ID conflicts and finding and removing duplicates.
Once FontDoctor has reviewed all the font files, the Diagnosis dialog box lets you decide how to handle any
potential problems.

Diagnosing Fonts
Depending on how many fonts you plan to examine, the diagnosis process can take a few seconds, a few
minutes, or over an hour. You may need to stay near your computer to respond to the diagnosis. To get start-
ed examining fonts:

1 Launch FontDoctor. The Diagnose/Repair Fonts tab displays by default.

2 To review the options for diagnosing corrupt fonts, click Diagnosis Options. Review the options in the Font
File Structure area and make changes as necessary. When you’re finished, click Save.

3 If you’re planning to examine all the fonts in nested folders, on a disk, on a hard drive, or on a volume,
check Include Sub-Folders. in the main window. This ensures that FontDoctor looks inside all the folders
to find all the possible font files.

The Include Sub-Folders check box, Diagnose Options button in the Diagnose/Repair Fonts tab.
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4 Specify which fonts you want to examine:

• To examine a single font or suitcase, choose Examine a Font File from the File menu or press ⌘+O.

• To select a volume, disk, or folder to examine, click Start Diagnosis or press the space bar. Click Select
A Fonts Folder to make your selection. You can also simply drag the volume, disk, or folder into the top
portion of the Diagnose/Repair Fonts tab.

Note: If FontDoctor notifies you that other applications are running, see the next step. 

Dragging a folder of fonts into the Diagnose/Repair Fonts tab.

5 If other applications are running—and therefore using font data—a dialog box lists all the applications. For
the most thorough and problem-free diagnosis, click Quit Applications. FontDoctor sends an Apple Event
message to each application to quit. If an application does not recognize the Apple Event message, double-
click it in the list, then use the application’s Quit command. If you do not wish to quit other applications,
click Continue.

The Quit Applications button shuts down other applications that may be using font data.

6 FontDoctor will begin scanning for font files and examining them. If you
need to cancel the examination process, press ⌘+period. 
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Check Don’t show this message again t o
ignore any running applications and automati-

cally proceed with the diagnosis. This box
stays checked until you quit FontDoctor. If
you never want FontDoctor to warn you

about running applications, you can set the
Always Ignore Other Running Applications
preference. Note that the Finder is not con-

sidered to be a “running application.”
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8 When FontDoctor encounters a problem, the Diagnosis dialog box displays. The problem is described at
the top and the affected fonts are listed in the middle. Click the disclosure triangle next to a font to see
more information about the font. At the bottom of the dialog box, buttons give you options for how to han-
dle the font problems. The area below the buttons provides helpful tips. The options work as follows:

The Diagnosis dialog box reports problems and lets you fix them. 

• More Details: Click this to display an explanation about the current diagnosis.

• Cancel: Click this to end the diagnosis process without further changes to your fonts.

• Continue: Click this to prevent FontDoctor from making repairs or changes to the diagnosed fonts in the
current list. 

• Move All: If a diagnosis, such as duplicate fonts, requires fonts to be moved from their current locations,
the Move All button displays. Click this to move all the fonts in the list to a folder called “Moved Fonts”
on the desktop. If you want to move a group of fonts, select them and click Move. (Shift+click the first
and last font in a range of continuous fonts or ⌘+click to select/deselect discontinuous fonts.) 

• Fix All: Click this to repair all the fonts in the list. If you want to repair a group of fonts, select them and
click Fix. (Shift+click the first and last font in a range of continuous fonts or ⌘+click to select discon-
tinuous fonts.) 

9 When the diagnosis and repair process is finished, a summary displays. Click OK to close the summary and
display a report. If you find the report information useful, you can save or print it. Otherwise, click Done.

The summary that displays at the end of the diagnosis process. 
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To locate the font file for a
font listed in the Diagnosis
dialog box, double-click it.

FontDoctor will bring the font
file to the front in the Finder.
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Note: If FontDoctor needs to move any fonts, a “Moved Fonts” folder appears on the desktop or in the loca-
tion you specify. Review the files in this folder and determine if you want to keep them or delete them. In par-
ticular, look in the Moved Damaged Fonts subfolder to see which fonts FontDoctor was unable to repair. You
may need to install new copies of these fonts.

Specifying and Customizing Diagnosis Options
The Diagnosis Options button in the lower-right corner of the Diagnose/Repair Fonts tab let you specify
what issues FontDoctor should look for in your fonts. While your first impulse may be to “just fix everything,”
keep in mind that what is a problem font for someone else is not necessarily a problem for you. For example,
it’s common for graphic designers and service bureaus to have many “duplicate” fonts because different
clients use different versions of the same font. In that case, you would not want FontDoctor to Diagnose
Duplicate Fonts. In addition, you can customize how these options work. For example, when diagnosing
Mixed Font Types, you can specify which type of fonts you prefer to keep. 

Consider what types of font problems you are having before checking the Diagnosis Options boxes. Each of
the Diagnosis Options are described in the following sections.

Diagnose Duplicate Fonts
Check Diagnose Duplicate Fonts to have FontDoctor determine if any of the examined bitmap fonts are
duplicates. FontDoctor considers a duplicate font to be a bitmap font with the same name, PostScript name,
and font style. FontDoctor will display a list of duplicates and let you decide what to do with them. If you
have no need for the duplicates, you can move them out of your font library and delete them to save hard
drive space. In that case, be sure you are keeping the versions of the fonts you want—for professional pub-
lishing, for example, you might keep the latest version of the Adobe PostScript or OpenType fonts, or for
cross-platform publishing you might keep the latest version of the OpenType or TrueType fonts. If you need
the duplicate fonts for different clients and projects, uncheck the Diagnose Duplicate Fonts option. 

Options for Diagnosing Duplicate Fonts

• Compare All Fonts: Click this to compare all the examined fonts in the search for duplicates.

• Compare Only Fonts Found in Different Folders: Click this to compare only fonts in different folders in the
search for duplicates. For example, you might use this to match duplicates that exist outside of a font fami-
ly folder, but not in the same folder.

• Always Keep Newest Version: Click this to have FontDoctor keep the newest version of a font when it
finds duplicated fonts.

• Move Duplicate Fonts To Trash Can: Check this to move any duplicate fonts to the trash can on the desk-
top. FontDoctor does not empty the trash so you can review the fonts before deleting them. When this
unchecked, the fonts are moved to the “Moved Fonts” folder.
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Diagnose Extra Font Sizes

Check Diagnose Extra Font Sizes to have FontDoctor locate PostScript Type 1 fonts with more than a single
size installed. The extra sizes are unnecessary and removing them eliminates the possibility that they may
become corrupt and frees up hard drive space. If you are not concerned with extra font sizes, uncheck this.

Note: Most bitmap fonts (not TrueType or OpenType) are created with incremental sizes included—such as 9
points, 12 points, 18 points, etc.—because the Mac OS internal font manager uses these different sizes to
draw fonts according to the size the user selects (even if the size is not specifically included with the font,
such as 13 point). For PostScript fonts, however, Mac OS does not require different bitmap sizes since it uses
the PostScript font file to calculate how to draw the proper font point size. 

Options for Diagnosing Extra Font Sizes
• Keep The Smallest Font Size: Click this to keep the smallest point size of a font. 

• Keep The Largest Font Size: Click this to keep the largest point size of a font. 

• Keep Closest Font Size: Click this to keep the point size you specify. If the specified size is not found,
FontDoctor will keep the closest match to the specified size.

• Move Extra Font Sizes To Trash Can: Check this to move any extra font size files to the trash can on the
desktop. FontDoctor does not empty the trash so you can review the fonts before deleting them. When this
unchecked, the fonts are moved to the “Moved Fonts” folder.

Diagnose Mixed Font Types

Check Diagnose Mixed Font Types to have FontDoctor locate different types of the same font—for example,
it’s very common to have a PostScript, TrueType, and dfont version of Helvetica. You may wish to keep all
these types or keep only one type of each font. (Why do you care? Because different types of the same font
may not flow text or print the same way. No matter what types of fonts you decide to use, it’s important that
anyone you work with is using the same fonts. In addition, the different types can cause problems for Mac
OS as it may not know which font to display and print.) Understanding the different font formats and their
ideal uses may help you decide how to handle mixed font types: 

• PostScript: PostScript fonts are actually made up of two files: the bitmap or screen font that displays the
font on-screen and the printer font that is sent to the printer. Usually, PostScript fonts consist of one printer
font and multiple screen fonts, which are packaged together in a suitcase. The suitcase contains screen
fonts for variations of the font such as bold, italic, condensed, etc. PostScript fonts, which are not cross-
platform, exist in two types: Type 1 and Type 3 (an older format). Type 3 fonts are known for causing print-
ing problems and they are not supported by Mac OS X.

PostScript fonts are used in desktop/professional publishing for printing to high-quality laser printers,
imagesetters, and plate-setters. If you are involved in publishing, you may prefer PostScript fonts.
Eventually, PostScript fonts will be replaced with the single-file, cross-platform OpenType format.
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• Tr u e Type: Tr u e Type fonts consist of a single file that Mac OS automatically scales to any size for display and
p r i n t i n g. In Mac OS 9/Classic, you can identify Tr u e Type fonts by the file icon’s three A’s. Although Mac OS
and Windows Tr u e Type fonts have the same characteristics, they have a different internal file type and are not
c r o s s-platform between Mac OS 9/Classic and Windows. (You can use FontDoctor to convert these fonts—
see “Converting Fonts to Different Formats”) Mac OS X does support Windows Tr u e Type fonts, but Windows
does not support Macintosh Tr u e Type fonts. 

Tr u e Type fonts are typically used in home and business environments with Microsoft Office applications
and web browsers. Although they are supported by most RIPs (high-resolution output devices), they are
not generally used in professional publishing. 

• OpenType: OpenType fonts consist of single, cross-platform files that can contain more than 65,000 sym-
bols or glyphs. This format is essentially a wrapper around TrueType and PostScript font data. This new 
format from Adobe and Microsoft and is supported by Mac OS 9/Classic, Mac OS X, and Windows. 

Note: The dfonts (datafork fonts) that come with Mac OS X are not checked by Diagnose Mixed Font
Types. The following dfonts are required by the system: AquaKanaBold, AquaKanaRegular, Geneva, Hei,
Keyboard, LastResort, LucidaGrande, and Monaco. Other dfonts that come with Mac OS X, however, are
not required by the system—and may conflict with your PostScript and TrueType fonts. These may include:
American Type, Apple LiGothic Medium, AppleGothic, Baskerville, BigCaslon, Copperplate, Courier, Didot,
Futura, GillSans, Helvetica, HelveticaNeue, Herculanum, Marketfelt, Optima, Osaka, OsakaMono, Papyrus,
Symbol, Times, ZapfDingbats, and Zapfino. You can move these out of the System Fonts folders so they are
no longer activated automatically. (For information about the location of the Mac OS X Fonts folders, see
“Appendix A: Working with Multiple Users on a Mac OS X System”.) 

Diagnosis Options for Mixed Font Types

• Prefer PostScript And OpenType Over TrueType: Click this to keep the PostScript or OpenType version of
a font and remove the TrueType version.

• Prefer TrueTypes Over PostScript And OpenType: Click this to keep the PostScript or OpenType version of
a font and remove the TrueType version.

• Move Non-Preferred Types To Trash Can: Check this to move any non-preferred fonts to the trash can on
the desktop. FontDoctor does not empty the trash so you can review the fonts before deleting them. When
this unchecked, the fonts are moved to the “Moved Fonts” folder.

Diagnose Font ID Conflicts

This option allows FontDoctor to perform a test to determine if any of the examined fonts have the same
font ID number. This test is performed only on bitmap and TrueType fonts. The Macintosh System uses a
special internal numbering system (known as Resource ID’s) to keep track of certain file types like fonts,
sounds, pictures, etc. Each font file has it’s own ID number stored within itself. When a font is opened, the
ID number is loaded and registered with the Macintosh’s internal font manager. If a font already exists with
the same font ID number and is already opened, then the resulting problem is called a “font ID conflict”.
When FontDoctor diagnoses a font ID conflict, it will identify the conflicting ID’s and can repair the conflict
by changing the ID number to a new unique number. FontDoctor automatically uses a random number gen-
erator to produce this new number. Note that Mac OSX will now temporarily resolve font ID conflicts for
you, as can many font manager applications, like Extensis Suitcase.
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Diagnose Missing PostScript Fonts and Diagnose Missing Bitmap Fonts

Check Diagnose Missing PostScript Fonts to have FontDoctor locate PostScript Type 1 bitmap (screen)
fonts that are missing their printer (outline) fonts—these fonts are sometimes called “orphan bitmaps.” You
should move these fonts out of your font library and reinstall them from their original installers to ensure that
you have both the bitmap font and the printer font. 

Check Diagnose Missing Bitmap Fonts to have FontDoctor locate PostScript Type 1 printer (outline) fonts
that are missing their bitmap (screen) fonts—these fonts are sometimes called “orphan outlines.” You should
move these fonts out of your font library and reinstall them from their original installers to ensure that you
have both the screen (bitmap) font and the printer (outline) font. 

If you are not concerned about orphans, uncheck these options. 

Note: PostScript Type 1 fonts, used for high-quality output devices such as desktop laser printers and com-
mercial imagesetters, consist of two files: the bitmap font (sometimes called a screen font) and the printer
font (sometimes called the outline font or the PostScript font). The bitmap font is used to display the font on-
screen and the printer font information is sent to the printer. Without both components, PostScript fonts do
not display and print correctly (often, the printing is “jaggy”). 

Options for Diagnosing Missing PostScript Fonts
• Styles (Bold, Italic, etc.) Require PostScript Font: Check this to have FontDoctor require that the bitmap

(screen) font for each type style (bold, italic, etc.) have its associated PostScript (printer) font. If the
PostScript font is missing for a style, the bitmap is considered an orphan. In some cases, you may not own
the printer fonts for various styles of a font but your service bureau does—in that case, uncheck this. 

Tech Note: When you apply a bold, italic, etc. type style from a menu in a program such as QuarkXPress or
Microsoft Word, a simulation of the font displays in the type style (bold, italic, etc.) on-screen. When you
print the font, the actual PostScript (printer) font for that style is required. Because of this, it’s better to apply
the actual version of the font—such as Garamond Bold—rather than applying a type style such as bold. 

• Diagnose Multiple Master Font Instances: Check this to ensure that the base font exists for each
instance of a Multiple Master font. If you uncheck this, FontDoctor will keep only the base fonts and none
of the user-created instances.

Tech Note: With Multiple Master fonts, a user starts with a Multiple Master PostScript font as a base (or
template) and creates modified font “instances.” Multiple Master font vendors such as Adobe provide the
software for creating font instances, though this technology is no longer being developed by Adobe.

• Move Orphaned Bitmap Fonts To Trash Can: Check this to move any bitmap fonts that are missing their
“sister” PostScript (printer) fonts to the trash can on the desktop. FontDoctor does not empty the trash so
you can review the fonts before deleting them. When this unchecked, the fonts are moved to the “Moved
Fonts” folder.
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Expert Options for Missing Bitmap Fonts

• Diagnose Type 1 PostScript Fonts: Check this to check all PostScript Type 1 PostScript (printer) fonts for
missing bitmap (screen) fonts. Type 1 fonts are the most common type of PostScript fonts. 

• Diagnose Type 3 PostScript Fonts: Check this to check all PostScript Type 3 PostScript (printer) fonts for
missing bitmap (screen) fonts. Type 3 fonts are an older, less popular type of PostScripts fonts; they are not
supported by Mac OS X.

• Move Orphaned PostScript Fonts To Trash Can: Check this to move any PostScript (printer) fonts that are
missing their “sister” bitmap (screen) fonts to the trash can on the desktop. FontDoctor does not empty the
trash so you can review the fonts before deleting them. When this unchecked, the fonts are moved to the
“Moved Fonts” folder.

Font File Structure Options

The options in the Damaged & Corrupt Fonts area let you specify what FontDoctor is looking for when
examining fonts for corruption. 

DIAGNOSE MISSING STYLE RESOURCES

Check this to examine fonts for missing style resources and repair them as necessary. FontDoctor repairs this
problem by correcting the reference to the missing resource data in the font files.

Tech Note: Each font file contains sections of data that describe the font characteristics, such as font size,
styles, and names. These sections of data are called “resources.” Each font contains a resource (called a
FOND resource) that refers to other resources within the font file, depending on which size and style is
selected by the user. You might think of this as a self-contained “table of contents” used by Mac OS for
each font. If the font file “table of contents” indicates that there is additional font data in a resource within
the font file for a selected size or style, Mac OS looks for that resource in the font to get the data, and then
draws the selected font on-screen. Occasionally, when Mac OS attempts to retrieve the data after looking it
up, that resource may be missing or damaged. In that case, Mac OS may crash or substitute the font. 

DIAGNOSE EMPTY SUITCASE FILES

Check this to locate and remove any empty font suitcases; the empty suitcases are moved to the “Moved
Fonts” folder. Empty suitcase files contain no fonts, are functionally useless, and are consuming hard drive
space—they should be deleted if you are not going to use them. 

EXAMINE BITMAP TABLE DATA

Check this to examine the table data of each font file. If inconsistencies are found, FontDoctor will alert you.
Depending on exactly which table is damaged, FontDoctor may be able to fix the table or it will suggest that
you remove the font.

Tech Note: Each bitmap font and Tr u e Type font contains data Mac OS uses to draw the font on-screen. This
file data is organized into related groups called “tables.” These tables contain information about a font’s style,
size, ke r n i n g, etc. The tables of each font are in constant use as Mac OS looks up the information needed to
draw the font. During this “look- u p” process, Mac OS actually reads the tables from the opened font disk file
and loads them into memory before it can use the data. If Mac OS crashes while these tables are still “loaded”
into memory, the tables in the font disk file can become damaged or corrupt. FontDoctor examines each of
these tables and looks for data that is not consistent with the font design. 
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EXAMINE FINDER FILE FLAGS

Check this to examine each fonts “finder flags,” which indicate the status of a file (busy, visible, etc.).
FontDoctor looks at these flags, and then checks the actual conditions the flag is set for. If a flag indicates a
condition that isn’t true (for example, the file has a custom icon, when in fact it does not), FontDoctor will
alert you. You can have FontDoctor reset the file flags to accurately reflect the true conditions of the file. 

Tech Note: Mac OS uses a system of flags or markers to mark each file on your hard drive. These flags are
set to indicate certain conditional information about every file. The flags are set and updated by Mac OS and
the file information changes regularly. There are flags that indicates if a file is busy, if a file is visible to the
user, if a file has a Finder label, if a file has an icon, if the file is actually an alias, etc. Over time, these flags
can get set incorrectly. Incidentally, these flags are sometimes called “file bits” or “Finder flags” because
each flag is made up of a single bit of information used by the Finder.

FIND OLD FONT RESOURCE TYPES

Check this to update any fonts with the old, less-efficient resource type of “FONT” to the newer, more effi-
cient resource type of “NFNT.” 

Tech Note: Modern fonts are built with a new resource type called an “NFNT” resource. The old style
“FONT” resources can significantly slow down the performance of some Mac OS applications. FontDoctor
will convert these older fonts to the newer “NFNT” resource type. 

DIAGNOSE POSTSCRIPT FONT FILE NAMES

Check this to have FontDoctor examine and repair (i.e re-name to it’s proper name) the file names of any
PostScript fonts. A “wrong” file name for PostScript fonts can cause font problems for Mac OSX. Note that
PostScript file names may not cause problems with earlier version of the Mac OS.

The Moved Fonts Folder

After diagnosing fonts, if necessary, FontDoctor creates a folder called “Moved Fonts.” The Moved Fonts fold-
er is used to isolate fonts it cannot repair or to contain fonts that are no longer useful such as extra font sizes
or empty suitcases. You can review the files in the Moved Fonts folder and determine if you want to keep
them or delete them. 

By default, the Moved Fonts folder is created on the desktop. 

CREATE “MOVED FONTS” FOLDER ON DESKTOP

This option will allow FontDoctor to automatically create the “Moved Fonts” folder on the desktop without
asking. When unchecked, FontDoctor will ask you where you would like to create the “Moved Fonts” folder
before it continues to examine your fonts. FontDoctor uses the “Moved Fonts” folder to store fonts that are
damaged beyond repair or are no longer useful, like extra fonts sizes or Empty suitcase files.
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The contents of the Moved Fonts folder on the desktop.

Diagnose Only (do not repair or move fonts)
In some circumstances you may want FontDoctor to simply report it’s diagnosis without offering to repair or
move any font file data. Check this option if you would want FontDoctor to generate a report only.

Reset Settings

This button will allow FontDoctor to automatically restore all of the Diagnosis Options to the original setting
that came with FontDoctor.

Printing Reports
When FontDoctor is finished diagnosing your fonts, click Generate Report. The report shows which fonts
were examined, how many of each type were found, and the results of the diagnosis.

If you want to keep this information for future reference, click Save Text or Print. Otherwise, click Done. 
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A FontDoctor Report that displays after diagnosing and repairing a folder of fonts.
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Organize Fo n t s
It’s very common for Mac users to have many fonts spread throughout folders all over their computers—
fonts that came with applications, fonts downloaded from the Internet, fonts from clients, fonts you have pur-
chased, and more. As a result, it’s very easy to become confused about what fonts you have and where they
are. FontDoctor’s Organize Fonts tab provides an easy solution to this: the automatic creation of a highly
organized new font library folder. If you already have a fonts library, you can automatically move other fonts
into it as well. 

Before creating the font library, FontDoctor performs its diagnosis and repair process to ensure that all the
fonts are usable. Fonts are then moved or copied to a new folder according to your preferences. Since every-
one’s workflow and habits are different, FontDoctor provides many options for creating the new font library.
When you’re finished reorganizing fonts, you can print a report about how many fonts were found, what type
they are, and more.

The Organize Fonts tab. One option for a new font library is to organize fonts by
typeface family.

Demo Note: The demo version of FontDoctor will create new font folders for the organization you specify—
so you can see how the folders look—but fonts will not be moved into the folders.
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Before you reorganize your fonts, review all the options in the Organize Fonts tab to ensure that the new font
library will suit your needs. After reorganizing fonts, you may need to add them to your font manager again.
To organize fonts:

1 Launch FontDoctor. Since FontDoctor will diagnose and repair fonts before reviewing them, first review the
options in the Diagnose/Repair Fonts tab (be sure to click Diagnosis Options as well). When you’re fin-
ished, click the Organize Fonts tab.

2 Use the Search Disks/Folders for Fonts area to specify which drives, folders, and media to search when
building your new font library. To add a folder, hard drive, mounted server, CD, Zip disk, etc., to the list, drag
it into the Search Disks/Folders for Fonts area or click the folder icon and select the item.

• To search an item in the list, check it or double-click it. 

• To exclude an item in the list from the search, uncheck it or double-click (if it’s already checked).

• To remove an item from the list, select it and click the trash icon.

The Search Disks/Folders for Fonts area.

3 Check Include Sub-Folders to examine all the fonts in nested folders, on a disk, on a hard drive, or on a
volume. This ensures that FontDoctor looks inside all the folders to find all the possible font files. (Note that
other file types are ignored. For information about how font file aliases are handled, see “Disk
Management”) Uncheck this to search only the top level of a drive, folder, or other media.

4 Specify how to organize the files in the Example Folder Layout area. The area itself displays a preview
according to options you set at right. 

• To create alphabetical folders (numerals followed by A–Z) that will contain fonts in the new font library,
check Create Alphabetic Folders. Note that FontDoctor will not create any unnecessary folders—if not
fonts are found that start with X, for example, an X folder will not be created. To skip the creation of
these folders—for example, if you want family name folders only—uncheck this. 

• To create a folder for storing each font family, check Create Family Name Folders. If Create Alphabetic
Folders is checked as well, the families are stored within their first letter’s folder. To skip the creation of
family folders—for example, if you want fonts stored only in alphabetic folders—uncheck this.

• To simply organize all your fonts into the same folder with no subfolders, uncheck both Create
Alphabetic Folders and Create Family Name Folders.
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The Example Folder Layout area and the Create Alphabetic Folders and Create Family Name
Folders check boxes.

5 If you want FontDoctor to delete any empty folders remaining after fonts are
moved into the new font library, check Delete Empty Folders After Move.

The Organize Options window

6 Specify which types of fonts to include in your new font library by checking boxes in the Organize Options
window by clicking the Organize Options button. Any fonts that you choose not to include are left in place;
FontDoctor does not move or delete them. 

• Find Bitmap/PostScript Fonts: Check this to include bitmap fonts and their associated PostScript fonts,
if any, in the font library. Note that PostScript fonts missing their bitmap fonts will not be included in the
new font library, but bitmaps fonts missing PostScript fonts will, if any, be included.

• Find TrueType Fonts: Check this to include TrueType fonts or TrueType font suitcases (including the 
Mac OS X .dfont format) in the font library.

• Find Windows TrueType Fonts: Check this to include Windows TrueType fonts in the font library.
Windows TrueType fonts always have the “.ttf” file name extension. Note that FontDoctor does not 
support Windows TrueType Collections (.ttc file name extension) files.
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• Find OpenType Fonts (.otf): Check this to include OpenType fonts in the font library. OpenType fonts will
usually have the “.otf” file name extension.

• Find Multiple Master Fonts: Check this to include Multiple Master fonts (and their instances) in the font
library. Note that Multiple Master fonts are supported by Mac OS 9/Classic and Mac OS X version 10.2
(Jaguar) and higher, but not by previous versions of Mac OS X.

You may also want to consider using the other available options when creating a new font library:

• Uncheck Skip System Folder to have FontDoctor move and organize fonts in both the Mac OS 9/Classic
and Mac OS X System Fonts folders. FontDoctor will not move any fonts required by either system. 
To leave fonts in all the System Fonts folders where they are, check Skip System Folder. Note that you
must be logged in as the administrator in Mac OSX in order to work with the system fonts
folder(s). See your Apple Macintosh documentation for more details.

•Diagnose Corrupt Fonts Before Building New Library: Check this option to have FontDoctor diagnose
and repair corrupt and damaged fonts before it adds them to the new font library. If this is unchecked
then FontDoctor will not diagnose the fonts before adding  them to the new font library.

•Create Separate Suitcase Files for TrueType Fonts and Bitmap Fonts: Check this option  to have
FontDoctor create separate font files that contain TrueType and Bitmap versions of the same font. If
unchecked, then FontDoctor will include both versions of the font in the same Suitcase.

•Append “Folder” to New Font Folder Names: Check this option to have FontDoctor add the word
“Folder” to the end of a new folder that it creates for font families, font name folders, etc.

•Allow “Style-Only” Fonts in Library: Check this to have FontDoctor include any fonts that exist without
a “plain” version. These fonts always have a style name included in parenthesis as part of their file name.
While they are usually considered problematic, some people want to keep them. When unchecked,
FontDoctor will not include these fonts.

•Keep Different Versions of the Same Font: Check this to have FontDoctor keep any different versions of
the same font that it finds. Of checked, FontDoctor will put the different versions in a separate suitcase
file and increment it’s name with a number, like Helvetica 1, Helvetica 2, etc. When unchecked,
FontDoctor will keep the newest version and ignore the older ones, if any.

• Click Use Font Family Names to store fonts in the appropriate font family suitcase. For example,
HelveticaNeue HeavyExt will be stored in the HelveticaNeue family suitcase along with other font family
members such as HelveticaNeue HeavyCond, HelveticaNeue Heavybold, etc.

• Click Use Font Names to create a new font suitcase for each font found in a custom suitcase. For exam-
ple, the font HelveticaNeue HeavyExt will be stored in a new HelveticaNeue HeavyExt font suitcase. 

• When creating new suitcases, FontDoctor can move fonts or copy fonts to the new font library. To move
fonts, deleting them from their previous locations, click Delete Original Files.

7 Once you’ve specified how to set up your new font library, click Create Library. You can create an entirely
new folder for the font library or add the found fonts to an existing font library folder.
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• To select an existing fonts folder, click Select and navigate to it.

• To create a new fonts folder, click New and specify a name and location for the folder.

Note: If you already created a new font library with FontDoctor, it will ask if you want to add fonts to the
existing font library folder or if you would like to create a new font library folder.

8 When FontDoctor is finished organizing your fonts, click Generate Report. The report shows what
FontDoctor searched, where it created the new library, how many fonts were found, and how many fonts
were added to the new library.

If you want to keep this information for future reference, click Save Text or Print. Otherwise, click Done. 

A FontDoctor Report about organizing fonts.
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Archive Fo n t s
FontDoctor allows you to create a font archive file that contains back-up copies of your font files. FontDoctor
can work with the created font archive file to easily locate and restore your fonts quickly either to a selected
location or back to a file's original location. FontDoctor creates a font archive file that will contain all of the
font data that you choose to have archived. This single-file design makes the archive file easy to store, copy,
move, or transfer with less risk of data loss.

The Archive Fonts tab.

To archive your font files, first click the Archive Fonts tabbed panel in the main window of FontDoctor. Initially
you will notice that most of the controls are disabled (i.e. grayed out). This means that there is currently no
Archive file opened. If you would like to open an existing font archive file, click then "Open Font Archive File"
button, otherwise you may want to begin by creating a new font archive file.

Creating a New Font Archive File
To create a new font Archive file, click the Archive Fonts button in the Archive Fonts tabbed panel. You will
be prompted to select a folder that contains the font files you would like to copy into the new Archive file.
Once you've located the folder that you want to archive, click the Select button.

Next, you will be prompted to choose where you would like FontDoctor to save the new font archive file. Use
the controls in the dialog window to select a location, then click the Save button.



After selecting the fonts to archive and selecting a location to save the archive file, FontDoctor will begin to
search the selected folder for font files to be included in the archive file. Note that FontDoctor performs a very
basic file examination as it is collecting font file data for the archive. The archiving process can be cancelled
at any time by clicking the Cancel Archive button, or by holding down the command key and typing a peri-
od.(⌘+.)

When the search process is complete, FontDoctor will automatically begin to add the fonts to the archive file.
Because the archive file is a single portable file, the fonts are first converted to a special data format before
they are stored in the archive file. As such, the archiving process may take some time, depending on how
many font files you have selected to be added to the archive. Once done, FontDoctor can generate a report
about  how many fonts where found and any problems identified in the process. This report can be viewed by
clicking the Generate Report in the Archive Fonts tabbed panel of the main window.

Using An Archive File
Once you have created an archive file (or have opened as existing archive file) FontDoctor will list the
archived font file names in the Font File Name list of the Archive Fonts tabbed panel in the main window of
FontDoctor. This list is where you will locate font files to be restored or removed from the archive.

Information about the font archive file is shown in the Font Archive Information area of the Archive Fonts
tabbed panel in the main window.

To close an opened archive file, click the Close Current Font Archive button.

Restoring Archived Font Files
On occasion you will want to restore a font file from a font archive file. FontDoctor provides several easy
ways to do this. Fonts can be restored from an opened archive file by using the Font File Names list, or by
typing a font name or filename in the Find field of the Archive Fonts tabbed panel.

Using the Font File Name List
To restore font files from the Font File Name list, scroll through the list and select the font files that you want
to restore. You can hold down the Shift Key while clicking in the list to extend your selection continuously, or
hold down the Command Key (⌘) to make a discontinuous selection in the list. Once you have selected the
font files that you want, click the Restore Selected Files button. Alternatively, you may want to double-click
a font file name in the list to see the Font Information window. In a Font Information window you can click
the Restore This File button to restore a particular font file.

Using the Find Field
To restore font files using the Find field, just type a file name or font name into the Find field, then click the
Find button. FontDoctor will show a Font Information window for each file that matches the Find field text
that was typed in.
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The Restore Options window.

Using the Restore Options
When restoring files from a font archive FontDoctor will present several restore options in a window that are
designed to provide powerful flexibility and ease of use for restoring your font files from an Archive. 

Restore Files to a Selected Folder

This option will cause FontDoctor to prompt you to select a location to save the files that are being restored.

Restore Files Back To their Original Folders
This option will allow FontDoctor to restore the selected font files back to their original folders (i.e. where
they were copied from originally). Note that this option requires that the original hard drive be mounted and
available, otherwise FontDoctor will be unable to restore the fonts back to their original folders and will report
an error message.

Restore Selected Files Only
This option will allow FontDoctor to restore only the files that have been selected, either through the Font File
List in the Archive Fonts tabbed panel of the main window in FontDoctor, or by clicking the Restore This
Font button in a Font Information window.

Restore Original Folder that Contains the Selected File(s)
This option will allow FontDoctor to restore all of the font files that were archived in the same folder as the
selected font file. This option is useful if you have your fonts grouped together in family folders and want to
restore the entire family folder without having to select each font file in the list.
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Include Original Folder Structure

This option will allow FontDoctor to recreate the original folders and enclosing sub-folders when the font file
was originally archived. Note that while the folder structure will be recreated, any files that may have been
enclosed by the recreated folders will not be included, other than the ones that were selected.

Overwrite Existing Files with Restored Files

This option will allow FontDoctor to delete any files that may be copies of the files being restored and will
replace them with the newly restored version(s).

Archive Options
The Archive Options button will resent the Archive Options window that contains various controls that allow
you to set any available options related to font archiving.

The Archive Options window.

Optimize Archive File After Font Files Are Removed (reduces file size)
This option will allow FontDoctor to sort through the current archive file (i.e. opened) and remove any extra
file space, thereby reducing the archive’s file size. Note that this process may take some time depending on
the size of the Archive file.

Remember Last Opened Archive File

This option will allow FontDoctor to re-open any archive file that was open when FontDoctor was last Quit.

Reset Settings

This option will force FontDoctor to reset the default settings for the Archive Options window.
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Inspect Fo n t s
The Inspect Fonts window lets you identify and locate special characters within a font, preview custom text
in a font, and print samples of fonts. A pop-up menu below the ASCII Character Set table lets you choose a
font to work with. If the font you’re interested in does not display in the pop-up menu, quit FontDoctor, acti-
vate the font, and then relaunch FontDoctor. To open the Inspect Fonts window, select Inspect Fonts from
the Tools menu.

The Inspect Fonts window.

Finding Special Characters
Whenever you need to see the entire character set within a font (such as the symbols in Zapf Dingbats) 
or find out the keyboard command for entering a special character (such as Option+8 for a bullet in most
fonts), use the Inspect Fonts window.

1 Choose a font from the pop-up menu below the ASCII Character Set table. 

2 Click any character in the table. The character displays in the square preview area at left; you can zoom in
on the character by dragging the scroll bar up.

The character preview area and the ASCII Character Set table.

INSPECT FONTS



3 Locate the keyboard command for the special character below its preview.

Previewing and Printing Font Samples
If you want to see how specific text—such as the characters in a logo or tag line—look in a specific font,
you can customize the size and text used for previewing. You can also print samples of fonts with the default
text or customized text. The Print Sample area in the lower-left corner of the Inspect Fonts window provides
these features.

1 Choose a font to preview and/or print from the pop-up menu below the ASCII Character Set table. 

2 In the Print Samples area, select a point size from the pop-up menu to specify the size of the type in the
preview field. (Printed font samples always include the sample text at 72, 35, 18, 12, 9, and 7 point.)

3 Enter or paste a word, phrase, or sentence into the field. FontDoctor uses this text for previews and printed
samples. 

The Print Samples area of the Inspect Fonts window.

4 To see a bold and/or italic simulation of the font, check Bold and/or Italic below the font pop-up menu.
Note that this displays a simulation—not necessarily the bold or italic version of the selected font. For
printed samples, it’s better to select the actual bold and/or italic version of the font. 

5 To see the current text in the selected font at various sizes, click Preview.
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• Use the Previous and Next buttons in the preview window to scroll through the active fonts in alpha-
betical order.

• Use the zoom controls in the lower-right corner to magnify the preview.

The preview window.

6 To print the current preview page, first click Page Setup to confirm the printer settings. 

7 Click Print Sample Page to send the page to the printer.
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Converting Fo n t s
FontDoctor lets you convert TrueType fonts from Mac OS to Windows format and vice versa for cross-plat-
form use, and it lets you convert Mac OS X dfonts to suitcases and vice versa for use with different versions
of Mac OS. The converted fonts are actually copies of the original fonts, and the original fonts are left intact.
You can convert one font at a time or convert an entire folder of fonts at one time. 

1 Choose Convert Fonts from the Tools menu or press ⌘+F.

2 In the Conversion Formats area, click the button for the type of conversion you want to perform. 

• Macintosh Tr u e Type To Windows Tr u e Ty p e : This option converts Macintosh Tr u e Type font files or suit-
cases to Windows Tr u e Type files (.ttf). Although FontDoctor will convert any Tr u e Type font file, some Apple
fonts may not work properly (for example, system fonts such as Charcoal, Chicago, Geneva, and Monaco). 

• Windows TrueType To Macintosh TrueType: This option converts Window TrueType font files (.ttf) to
Macintosh TrueType font suitcases. Note that FontDoctor cannot convert Windows TrueType Collections
(.ttc) files.

• DataFork Font (.dfont) To Macintosh Suitcase: This option converts Apple DataFork font files (.dfont) to
Macintosh suitcases.

• Macintosh Suitcase To DataFork Font (.dfont): This options converts Macintosh suitcases to Apple
DataFork font files (.dfont).

The Convert Font dialog box.

3 If you want to save the converted fonts in the same folder as the original fonts, check Save Converted
File(s) in Original Folder(s). If you prefer to specify a new destination for the converted fonts, uncheck this.

4 You can convert all the fonts in a folder at once by checking Batch Process Selected Folder. To convert
fonts inside folders within the selected folder, check Include Sub-Folders as well. 

5 Click Select Font File. Use the directory dialog box to locate a font file or folder of font files to convert. If
Save Converted File(s) in Original Folder(s) is unchecked, you will need to select a destination folder for the
new fonts. When you’re finished converting fonts, click Done.
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Windows TrueType fonts to
Mac OS fonts—both font

managers can handle them
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Moving Fonts within Suitcase Fi l e s
FontDoctor lets you move fonts from one suitcase to another—an especially useful feature for Mac OS X
users because the Finder no longer provides this capability. You might do this to combine similar typefaces
into the same suitcase (for example, you might combine Caslon Open Face and Caslon Old Face into a single
suitcase as shown below), or to create a set of fonts that are all within the same suitcase. Mac OS 9 users
commonly combine fonts into fewer suitcases to get around the systems’ limit on the number of active font
suitcases. You can also copy fonts between suitcases, create new suitcases, and delete fonts from suitcases
using FontDoctor.

Moving and Copying Fonts within Suitcases
To move or copy fonts from one suitcase to another:

1 Choose Move Fonts from the Tools menu or press ⌘+E.

2 On the left side of the dialog box, click Open Font Suitcase File.

3 Navigate to the suitcase file containing the fonts you want to move. Select it and click Open.
Note that you cannot open OpenType fonts, dfonts, or other types of fonts.

4 On the right side of the dialog box, click Open Font Suitcase File.

5 Navigate to the suitcase file you want to move or copy the fonts to. Select it and click Open.

The Move Fonts dialog box.

6 Select the fonts you want to move or copy (Shift+click the first and last font in a range of continuous fonts
or ⌘+click to select discontinuous fonts). 

7 To move the fonts, drag them to the other suitcase. To copy the fonts, press the Option key while you drag
them to the other suitcase.

8 When you’re finished moving the fonts, click Close Font Suitcase File for both open suitcases. 
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Deleting Fonts from Suitcases
Deleting a font from a suitcase deletes the font from your system. To delete a font from a suitcase:

1 Use the Open Font Suitcase File button to open the suitcase. 

2 Select the fonts you want to delete (Shift+click the first and last font in a range of continuous fonts or
⌘+click to select discontinuous fonts). 

3 Click the trash button in the center of the dialog box. 

Deleting a font from an open suitcase. This suitcase was created to hold all the fonts for a company’s corporate identity.

4 When the alert displays, click OK.

5 Click Close Font Suitcase File.

Creating New Suitcases
You can create a new suitcase to contain the fonts in the open suitcase at left. The new suitcase is always
opened on the right side of the Move Fonts dialog box. To create a new suitcase for fonts:

1 Click the new suitcase button (above the trash button) in the center of the 
dialog box. 

2 Use the Save dialog box to specify a name and location for the new suitcase. 

3 Click Save to create and open the new suitcase. 

4 Copy or move fonts into the suitcase, and then click Close Font Suitcase File.
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Setting Pr e f e r e n c e s
FontDoctor’s preferences let you customize how various features work, including printing reports, organizing
fonts, and matching PostScript fonts’ bitmap and outline files. To open the Preferences dialog box, choose
Preferences from the FontDoctor X menu (Mac OS X) or the Edit menu (Mac OS 9). You can also press
⌘+Y. When you’re finished altering preferences, click Save to implement the changes.

The FontDoctor Preferences dialog box.

Report Printing Options
When you click the Generate Reports button in the Diagnose/Repair Fonts tab or the Organize Fonts tab,
FontDoctor prints a summary of how many fonts were examined, the font types, the problems found, and
how the problems were handled. The formatting, file format, name, and location of the report are based on
the following preferences:

The Report Printing Options area of the Preferences dialog box.

• Font and Size: Select from the list of active fonts and enter a point size between 1 and 99 to specify the
formatting of the report.

• Default Report File Name: Enter a default name for the report file in this field.
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• TextEdit, BBEdit, Plain Text File Formats: Click the option for the file format you prefer for reports. In 
Mac OS 9, the Plain Text option creates a SimpleText file; note that Mac OS limits the size of SimpleText
files to under 32 K.

• Include Font Path Names in Report: Check this to list the entire path to each font file listed in the report.
With the path information, you can easily locate each font listed. 

• Automatically Save Report in Folder: Check this to automatically place a report file in the first level of the
folder selected for examination. For example, if you examine a folder of fonts on the desktop called
“Downloaded Fonts,” the report is saved in the Downloaded Fonts folder.

Resolve File Aliases
Check this to have FontDoctor locate and diagnose original font files according to their aliases; this option
also locates folders according to aliases. (An alias is not actually a file, but rather a pointer to a file.) If, for
example, you are diagnosing your Font Reserve Database folder, and you selected Leave in Place when you
added the fonts to Font Reserve, the database consists of nothing but aliases. When this is unchecked,
FontDoctor ignores aliases.

Preserve Apple System Bitmap Fonts
Check Preserve Apple System Bitmap Fonts to have FontDoctor ignore any Apple System bitmap fonts
installed for Mac OS 9/Classic. (These fonts, installed in the Fonts folder inside the System Folder, include
Charcoal, Chicago, Geneva, and Monaco.) Previous versions of Mac OS used these fonts to display buttons,
text fields, icon names, etc., so it is best to leave them out of the examination and diagnosis process. If you
are concerned about the integrity of these fonts, reinstall them from the Apple System installer CDs provided
with your Macintosh. 

NOTE: APPLE SYSTEM FONTS ARE TYPICALLY TRUETYPE FONTS AND/OR BITMAP FONTS, NOT
POSTSCRIPT FONTS. IF YOU UNCHECK THIS PREFERENCE, FONTDOCTOR WILL TREAT THE APPLE
SYSTEM FONTS AS IT WOULD ANY OTHER FONT FILE, INCLUDING REQUIRING A POSTSCRIPT FONT
FOR EACH BITMAP, DIAGNOSING EXTRA SIZES, ETC.

Ignore Other Running Applications
Check Always Ignore Other Running Applications to have FontDoctor ignore applications that may be using
fonts at the start of the diagnosis process. When checked, the Quit Applications alert will not display when
you begin examining fonts, although fonts used by those applications will still be examined. 

Diagnose & Repair In Unattended Mode
Check the Diagnose & Repair in Unattended Mode option to have FontDoctor automatically finish diagnos-
ing and repairing fonts without stopping for user user interaction (i.e alert boxes, dialog boxes, etc.) When
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checked, FontDoctor will automatically click the default buttons of any dialog windows that may appear and
will then continue uninterrupted, until finished.

Require Password for Preferences and Options
Check Require Password for Preferences and Options button to have FontDoctor require a password
before any adjustments can be made to the Preferences and Options windows in FontDoctor. This is useful
for system Administrators or user who do not want the settings changed without password protection.

Memory Slider Control
Use the memory slider control to adjust how much free memory you want to allot for FontDoctor while it is
searching and repairing fonts. This is useful if you have a very large number of fonts. Note that the default
setting (in the middle) is almost always adequate, but you may want to move the slider towards “More” if
you have the available memory (RAM) as this may allow FontDoctor to work faster in some conditions.
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A p p e n d i c e s
Appendix A: Working with Multiple Users on a Mac OS X System

Mac OS X is designed from the ground up to provide an environment that easily supports multiple users on a
single computer. Each user can set up the system in a way that fits his or her work style, including individual
fonts and preferences. 

Mac OS X accomplishes this by managing individual Library folders. Each of these Library folders contains its
own related folders, including a Fonts folder within each Library folder. As new users are created, new Library
folders (and new Fonts folders) are created by the system for them. Additionally, the System manages its
own Library folder, and manages a Library that is the base for a local machine, and manages a Library that is
used on a network of users. Understanding the location and function of the Mac OS X Fonts folders is critical
to good font management because:

• When a user logs into the system, fonts in his or her Fonts folders are activated automatically by the system. 

• Folder access privileges and user access privileges may affect the way FontDoctor is able to diagnose and
repair your fonts. 

Taking the time to understand how to work in a multi-user environment will go a long way toward helping
you take full advantage of FontDoctor’s features. Consult your Mac OS X manual for more details about multi-
ple users and shared files. If you are using a font manager such as Suitcase or Font Reserve, consult its user
guide to determine how it handles multiple users. 

Local User Fonts Folder

<hard drive> / Users / <user name> / Library / Fonts
This Fonts folder is located in the Users folder on the start-up drive. In the Users folder there is a folder for
each log-in user that has been set up on the system. In each user’s folder, there is a Library folder that con-
tains a Fonts folder. Users can add or remove their own private font files using this folder. Users will not have
access to other user’s folders unless they have been set up with access privileges to those folders.

Local Library Fonts Folder

<hard drive> / Library / Fonts
This Fonts folder is located in the Library folder on the start-up drive. This folder provides fonts for all applica-
tions running on Mac OS, regardless of which user is logged in. Fonts can be added or removed from this
Library by the Administrator only.
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Network Library Fonts Folder

<hard drive> / System Preferences / Network / Fonts
This Fonts folder is located in the Network folder of the start-up drive; it is typically available on systems that
are used as Network Servers and are maintained by a Network Administrator. Fonts in this folder are avail-
able to all users on a shared network volume.

System Library Fonts Folder

<hard drive> / System / Library / Fonts
This Fonts folder is located in the System folder on the start-up drive. These fonts are used by the System
and should not be altered.

Classic Fonts Folder

<hard drive> / System / Folder / Fonts
This Fonts folder is located in the System Folder on the start-up drive and is used by Mac OS 9 and Mac OS X.
This folder contains System Fonts for Mac OS 9 and should not be altered from within Mac OS X.
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Appendix B: Mac OS X Font Formats
Mac OS X supports some new font formats as well as extended support for existing font formats.
Additionally, some traditional formats are no longer supported.

Datafork Fonts (.dfont)

New to Mac OS X are DataFork fonts, identified by the “.dfont” file name extension. These files are identical
to a font suitcase on earlier Mac OS versions, except the information is stored in the data fork of the file,
instead of the resource fork. This new data storage scheme allows font files to transfer seamlessly between
systems such as UNIX or Windows without the risk of data loss that exists with traditional resource fork
suitcases. The Mac OS X version of FontDoctor fully supports the diagnosis and repair of DataFork font files
and can convert files between a font suitcase or a DataFork font file. (See “Converting Fonts to Different
Formats”)

OpenType Fonts (.otf)

Mac OS 9.2 and Mac OS X support a new font file format called OpenType, identified by the “.otf” file name
extension or by the word “Pro” appended to the font family name in the font menus (for example,
“HelveticaPro”). These font files are designed to include both TrueType and PostScript technology in a single
file, thus eliminating the need to maintain a separate PostScript file for a Type 1 font, as done traditionally.
Additionally, the OpenType format is supported on Mac OS and Windows systems, and can be transferred
effectively between the two. FontDoctor fully supports OpenType fonts.

TrueType Fonts
Mac OS X versions 10.1.2 and up support traditional Mac OS TrueType fonts as well as Windows TrueType
fonts (.ttf). FontDoctor also supports TrueType fonts from Mac OS or Windows, and can convert between the
two. (See “Converting Fonts to Different Formats”)

PostScript Fonts and Suitcases
Mac OS X supports PostScript Type 1 fonts and their suitcases; it does not support PostScript Type 2 or 
Type 3 fonts. FontDoctor will still diagnose PostScript Type 2 and Type 3 fonts as they are supported by 
Mac OS 9/Classic.

Multiple Master Fonts
Mac OS X 10.3 (and higher) does support Multiple Master fonts, and FontDoctor continues to support
Multiple Master fonts as well. Contact Adobe Systems for more information (www.adobe.com) about Mac
OS X support for Multiple Master fonts. Note that this technology has been deprecated by Adobe and by
Apple and is therefore no longer supported by them.

Bitmap Fonts
Mac OS X does not support older bitmap fonts (usually from System 6 and earlier). FontDoctor, however,
does support these older font formats and can update them for you. 
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Appendix C: FAQ
This section provides answers to frequently asked questions about FontDoctor. For the most up-to-date infor-
mation, please check our website at MorrisonSoftDesign.com.

Q. FontDoctor reports that some of my PostScript fonts are missing their bitmaps, even though I can plainly
see the bitmap font files! What’s going on?

A. If the affected fonts are all Apple System bitmap fonts (Helvetica, Palatino, Courier, Times, etc.), you
need to decide how you want FontDoctor to handle these fonts. The problem is, over the years, Adobe
has attempted to include PostScript fonts with the Apple System fonts as part of its font library. So
while Apple ships the System fonts with TrueType and bitmaps, they do not include PostScript font files
to go with the bitmaps—but the Adobe versions do. So FontDoctor needs to know whether you want it
to consider the Apple fonts as they were designed by Apple (without a PostScript font), or if you want
FontDoctor to require a PostScript font with each of the Apple bitmap fonts, as Adobe designed them. 

You might be now asking “Why can’t FontDoctor just tell the difference between the Adobe versions and
the Apple versions of the bitmaps?”. This is because Adobe broke the rules of font development by using
the same (and Apple restricted) internal font ID numbers the Apple fonts use. Therefore, from the
System’s and FontDoctor’s perspectives, they are the Apple fonts. The solution? To force FontDoctor to
“link” the Adobe PostScript fonts to the Apple bitmap fonts, uncheck the Preserve Apple System
Bitmap Fonts in the FontDoctor Preferences dialog box (⌘+Y).�

Q. FontDoctor won’t examine any folders that are inside the fonts folder I select. What’s the problem?

A. Make sure you check Include Sub-Folders in the Diagnose/Repair Fonts tab of the FontDoctor dialog
box. Also, if any of the sub-folders are actually aliases to other folders, be sure to check Resolve File
Aliases (find the original file) in the Preferences dialog box (⌘+Y).

Q. FontDoctor examines my System Fonts folders and reports that it repaired some fonts. When I run it
again, however, it reports the same thing. How come?

A. Since the System (not the Finder) is using the font data, it won’t let FontDoctor make permanent repairs
to the fonts (this is especially true for System 9 or earlier). In addition, since font data for System Fonts
may be only partially available, FontDoctor’s diagnosis may be partially incomplete. As a work-arounds,
you can either repair a copy of the System Fonts or startup your computer from a system CD:

• To repair a copy of the System Fonts, quit all applications and then Option+drag a copy of all the
System Fonts onto the Desktop. Run FontDoctor on the copied fonts, and then replace the old System
Fonts with the repaired ones. In Mac OS X, be sure to move fonts out of all the System Fonts folders
(listed in “Appendix A”); note that moving some of the System Fonts will require your administrator
password.

• To repair the fonts in place, start up your system with the Mac OS Startup CD that came with your
computer. You can then run FontDoctor on all the System Fonts folders—or on your entire hard
drive—without worrying about any font data being in use. 
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Q.After using the FontDoctor Diagnosis/Repair feature on my font library, my font management software
(Suitcase, Font Reserve, etc.) is unable to find or activate the fonts. What’s up with that?

A. Since FontDoctor moves some fonts to the Moved Fonts folder (usually on the desktop), you may need to
re-create your font sets according to the documentation provided with your font management application.

Q.How can I find out my FontDoctor serial number?

A. While FontDoctor is running, press the Option key while you choose About FontDoctor from the
FontDoctor X menu (Mac OS X) or the Apple menu (Mac OS 9). Your serial number will display in the
FontDoctor splash screen. 

Q.ATM Deluxe from Adobe keeps reporting that the “file offsets exceed the resource length” (or similar 
language) for some of my fonts. FontDoctor, however, finds no problems with these fonts. Who’s telling
the truth here?

A . We have inspected many of the fonts for which ATM Deluxe reports this error, but cannot find an issue with
them—especially with their table offset values. We have attempted to get an official response from Adobe
about this error, but haven’t heard anything yet. As far as we can tell, the error being reported by AT M
Deluxe appears to be inaccurate. 
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